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When	you	create	a	document,	do	you	consider	its	structure?	Similar	to	Microsoft	Word,	Google	Docs	provides	page	and	section	breaks.	These	tools	help	you	space	out	your	content	by	inserting	pages	and	creating	sections.	If	you're	new	to	using	page	and	section	breaks	in	Google	Docs,	we'll	walk	you	through	the	basics.	We'll	explain	how	to	insert
them,	hide	or	show	section	breaks,	and	remove	breaks	that	you	no	longer	need.	Add	a	Page	or	Section	Break	in	Google	Docs	Adding	a	break	in	Google	Docs	is	easier	than	you	might	think.	Open	your	document	and	place	your	cursor	where	you	want	to	insert	the	break.	Then,	click	Insert	>	Break	from	the	menu.	Choose	"Page	Break"	or	"Section	Break"
from	the	pop-out	menu.	Page	Break:	Drops	the	text	after	your	cursor	to	a	new	page.	Section	Break	(Next	Page):	Starts	a	new	section	on	the	next	page.	Section	Break	(Continuous):	Starts	a	new	section	on	the	same	(current)	page.	Page	breaks	are	ideal	if	you	have	a	heading	or	are	starting	a	new	paragraph	and	are	at	the	bottom	of	a	page	or	if	you	want
a	separate	page	for	each	topic	or	category	in	your	document	Section	breaks	are	handy	for	spacing	out	images	and	other	content	or	if	you	want	to	insert	columns	for	a	small	area	in	the	document.	Since	page	breaks	do	not	display	any	type	of	indicator	in	your	document,	there	isn't	a	way	to	show	or	hide	them.	As	you've	learned	above,	a	page	break
simply	starts	a	new	page.	Section	breaks,	on	the	other	hand,	have	a	blue	dotted	line	indicating	the	start	of	the	section.	While	this	section	indicator	is	helpful,	it	might	be	distracting	to	you.	Luckily,	you	can	hide	it.	Click	View	>	Show	Section	Breaks	in	the	menu.	This	deselects	it	by	removing	the	checkmark	and	the	blue	dotted	line	disappears.	To	show
the	section	breaks	again	later,	head	to	the	same	spot	in	the	menu	and	select	Show	Section	Breaks	to	put	a	checkmark	next	to	it.	You	should	then	see	those	dotted	lines	for	your	section	breaks	once	again.	If	you	insert	a	page	or	section	break	that	you	no	longer	want,	you	can	remove	it.	The	way	you	do	this	differs	on	Windows	versus	Mac	because	you'll
use	specific	keys	on	your	keyboard.	To	remove	a	page	break	in	Google	Docs	on	Windows,	place	your	cursor	in	front	of	the	text	at	the	top	of	the	page.	Then,	press	Backspace.	This	moves	the	content	up	to	the	previous	page.	To	remove	a	section	break	on	Windows,	place	your	cursor	on	the	line	directly	above	the	section	break.	This	is	easiest	to	do	if	you
have	Show	Section	Breaks	enabled.	Then,	press	Delete.	To	remove	a	page	break	in	Google	Docs	on	Mac,	place	your	cursor	in	front	of	the	text	at	the	top	of	the	page.	Then,	press	Delete.	This	moves	the	content	up	to	the	previous	page.	To	remove	a	section	break	on	Mac,	place	your	cursor	at	the	start	of	the	line	with	the	section	break.	Again,	you	can
enable	Show	Section	Breaks	to	make	this	simpler.	Then,	press	either	Fn+Delete	or	Control+D.	For	another	way	to	structure	your	document,	especially	if	it's	a	brochure	or	pamphlet,	take	a	look	at	how	to	create	multiple	columns	in	Google	Docs.	Page	breaks	and	section	breaks	are	useful	tools	in	Google	Docs	to	control	the	layout	and	formatting	of	your
document.	Here	is	a	comprehensive	guide	on	how	to	add,	view,	and	remove	these	breaks.To	add	a	page	break	in	Google	Docs:Place	your	cursor	where	you	want	the	page	breakClick	Insert	>	Break	from	the	menuSelect	Page	breakA	page	break	will	move	all	text	after	the	cursor	to	the	next	page.You	can	also	add	a	page	break	before	a	specific
paragraph:Select	the	entire	paragraph	or	place	your	cursor	anywhere	in	the	paragraphClick	Format	>	Line	&	Paragraph	Spacing	>	Add	Page	Break	BeforeThis	will	move	the	selected	paragraph	to	the	top	of	the	next	page.There	are	two	types	of	section	breaks	in	Google	Docs:Section	break	(continuous)	–	Starts	a	new	section	on	the	same	pageSection
break	(next	page)	–	Starts	a	new	section	on	the	next	pageTo	add	a	section	break:Place	your	cursor	where	you	want	the	section	breakClick	Insert	>	Break	from	the	menuSelect	the	type	of	section	break	you	wantSection	breaks	allow	you	to	have	different	headers,	footers,	margins	and	other	formatting	within	the	same	document.Page	breaks	in	Google
Docs	do	not	display	any	visible	indicator.	However,	section	breaks	have	a	blue	dotted	line	showing	where	the	section	begins.To	show	section	breaks:Click	View	>	Show	Section	BreaksTo	hide	section	breaks:Click	View	>	Show	Section	Breaks	to	uncheck	itShowing	section	breaks	helps	you	visually	see	where	your	sections	divide,	but	you	can	hide	them
if	you	find	them	distracting.To	remove	a	page	break:Click	under	the	page	breakPress	Backspace	or	Delete	key	until	the	page	break	is	removedYou	may	need	to	press	Backspace	or	Delete	multiple	times	to	completely	eliminate	the	break.To	remove	a	section	break:Make	section	breaks	visible	by	clicking	View	>	Show	Section	BreaksClick	above	the
section	breakPress	Backspace	or	Delete	key	to	remove	the	dotted	lineOnce	the	section	break	line	disappears,	the	section	break	will	be	eliminated.Here	is	a	comparison	of	page	breaks	and	section	breaks:|	Feature	|	Page	Break	|	Section	Break	||-|-|-||	Location	|	Moves	all	below	text	to	next	page	|	Starts	new	section	on	same	or	next	page	||	Visibility	|	Not
visible	|	Dotted	line	visible	||	Usage	|	Separate	topics	or	sections	|	Customize	formatting	within	document	||	Remove	|	Delete	under	break	|	Delete	above	section	break	line	|	Page	breaks	can	be	extremely	helpful	if	you	want	to	organize	your	content	in	Google	Docs.	In	this	article,	we	will	guide	you	on	how	to	insert	page	breaks	in	Google	Docs	and	also
explain	how	to	view	and	remove	them	from	your	document.	How	To	Add	Page	Breaks	in	Google	Docs	What	is	a	page	break	in	Google	Docs?	It’s	a	special,	non-printing	character	that	marks	the	end	of	a	page.	You	can	add	this	if	you	want	to	insert	a	new	page	without	completely	filling	up	the	current	one.	Inserting	a	Google	Docs	page	break	into	your
documents	offers	several	benefits.	For	one,	it	organizes	your	content	by	dividing	it	into	multiple	chunks.	Furthermore,	it	enhances	readability	by	providing	a	cleaner	and	more	structured	format.	Here’s	how	to	insert	page	breaks	in	Google	Docs:	Go	to	�and	open	your	document.	Navigate	to	the	document	section	where	you	want	to	add	the	page	break.
Click	on	“Insert”	in	the	menu	bar,	then	choose	“Break”	followed	by	“Page	break.”	Alternatively,	you	can	use	the	keyboard	shortcut	“Ctrl”	+	“Enter”	(or	“Command”	+	“Enter/Return”	for	Mac)	to	quickly	insert	a	page	break.	Did	you	know	that	you	can	also	insert	page	breaks	in	Google	Sheets	(and	assign	tasks)?	Check	out	our	comprehensive	guide	on
Google	Sheets	Page	Breaks	[How	to	Add,	Remove	&	More]	to	learn	more!	How	To	Insert	a	Section	Break	in	Google	Docs	A	section	break	is	another	feature	in	Google	Docs	that	functions	similarly	to	a	page	break.	A	section	break	helps	divide	a	specific	page	in	your	document	into	multiple	“sections”	or	“parts.”	So,	when	should	you	use	a	section	break?
One	useful	application	is	when	you	need	to	insert	multiple	columns	in	a	specific	area	of	your	document.	It’s	also	beneficial	when	arranging	photos	and	shapes	within	your	paper.	To	add	a	section	break,	follow	the	instructions	below:	Open	your	document	on	Google	Docs.	Click	on	the	part	where	you	want	to	insert	your	section	break.	Click	on	“Insert”	>
“Break”	and	choose	the	desired	option	from	the	menu	that	appears.	If	you	select	“Section	break	(next	page),”	the	next	section	will	start	on	the	following	page	of	your	document.	Alternatively,	if	you	choose	“Section	break	(continuous),”	the	section	break	will	be	inserted	within	the	same	page.”	How	To	Show	Page	Breaks	in	Google	Docs	Normally,	you
wouldn’t	see	page	breaks	in	Google	Docs	since	they	are	considered	“non-printing”	characters.	They	do	not	appear	when	you	print	a	physical	copy	of	your	document.	But	where	is	the	page	break	in	Google	Docs	that	you	just	inserted?	Here’s	how	to	see	page	breaks	in	Google	Docs:	Open	your	Google	document,	then	select	“View”	from	the	menu	bar.
Click	on	“Show	non-printing	characters”	from	the	options	available.	Alternatively,	you	can	use	the	keyboard	shortcut	“Ctrl”	+	“Shift”	+	“P”	(or	“Command”	+	“Shift”	+	“P”)	to	display	the	page	breaks.	How	To	Delete	Page	and	Section	Breaks	If	you	no	longer	need	page	and	section	breaks	in	your	document,	you	can	easily	remove	them	by	following
these	steps:	Open	your	Google	document	and	navigate	to	the	section	where	you	inserted	a	break.	Place	your	cursor	immediately	after	the	page	or	section	break.	Press	the	“Backspace”	key	on	your	keyboard	(or	“Fn”	+	“Delete”	for	Mac)	until	the	page	break	or	section	break	is	deleted.	You	can	treat	your	section	and	page	breaks	like	any	other	character
you	see	in	your	document.	Therefore,	you	can	delete	them	in	the	same	way	you	would	remove	words	from	your	work.	Frequently	Asked	Questions	What	Is	the	Shortcut	for	Page	Break	in	Google	Docs?	For	Windows	users,	press	the	keys	“Ctrl”	and	“Enter”	on	your	keyboard	to	insert	a	page	break	in	Google	Docs.	For	Mac	users,	press	“Command”	and
“Enter/Return”	simultaneously	instead.	What	Is	the	Difference	Between	a	Page	Break	and	a	Section	Break	in	Google	Docs?	If	you	insert	a	page	break,	you	can	only	continue	typing	and	adding	content	on	the	next	immediate	page	of	your	document.	However,	adding	a	section	break	divides	your	content	on	the	same	page.	Final	Thoughts	If	you	need	to
lay	out	your	document	properly,	page	breaks	in	Google	Docs	are	always	helpful.	Just	follow	our	guide	above,	and	you	should	be	able	to	insert	them	without	problems.	Want	a	quicker	way	to	make	progress	with	your	work?	Get	a	headstart	by	checking	out	our	premium	templates	today!	Use	the	code	“SSP”	to	purchase	them	at	50%	off.	Related:	Page
breaks	can	be	extremely	helpful	if	you	want	to	organize	your	content	in	Google	Docs.	In	this	article,	we	will	guide	you	on	how	to	insert	page	breaks	in	Google	Docs	and	also	explain	how	to	view	and	remove	them	from	your	document.	How	To	Add	Page	Breaks	in	Google	Docs	What	is	a	page	break	in	Google	Docs?	It’s	a	special,	non-printing	character
that	marks	the	end	of	a	page.	You	can	add	this	if	you	want	to	insert	a	new	page	without	completely	filling	up	the	current	one.	Inserting	a	Google	Docs	page	break	into	your	documents	offers	several	benefits.	For	one,	it	organizes	your	content	by	dividing	it	into	multiple	chunks.	Furthermore,	it	enhances	readability	by	providing	a	cleaner	and	more
structured	format.	Here’s	how	to	insert	page	breaks	in	Google	Docs:	Go	to	�and	open	your	document.	Navigate	to	the	document	section	where	you	want	to	add	the	page	break.	Click	on	“Insert”	in	the	menu	bar,	then	choose	“Break”	followed	by	“Page	break.”	Alternatively,	you	can	use	the	keyboard	shortcut	“Ctrl”	+	“Enter”	(or	“Command”	+
“Enter/Return”	for	Mac)	to	quickly	insert	a	page	break.	Did	you	know	that	you	can	also	insert	page	breaks	in	Google	Sheets	(and	assign	tasks)?	Check	out	our	comprehensive	guide	on	Google	Sheets	Page	Breaks	[How	to	Add,	Remove	&	More]	to	learn	more!	How	To	Insert	a	Section	Break	in	Google	Docs	A	section	break	is	another	feature	in	Google
Docs	that	functions	similarly	to	a	page	break.	A	section	break	helps	divide	a	specific	page	in	your	document	into	multiple	“sections”	or	“parts.”	So,	when	should	you	use	a	section	break?	One	useful	application	is	when	you	need	to	insert	multiple	columns	in	a	specific	area	of	your	document.	It’s	also	beneficial	when	arranging	photos	and	shapes	within
your	paper.	To	add	a	section	break,	follow	the	instructions	below:	Open	your	document	on	Google	Docs.	Click	on	the	part	where	you	want	to	insert	your	section	break.	Click	on	“Insert”	>	“Break”	and	choose	the	desired	option	from	the	menu	that	appears.	If	you	select	“Section	break	(next	page),”	the	next	section	will	start	on	the	following	page	of	your
document.	Alternatively,	if	you	choose	“Section	break	(continuous),”	the	section	break	will	be	inserted	within	the	same	page.”	How	To	Show	Page	Breaks	in	Google	Docs	Normally,	you	wouldn’t	see	page	breaks	in	Google	Docs	since	they	are	considered	“non-printing”	characters.	They	do	not	appear	when	you	print	a	physical	copy	of	your	document.
But	where	is	the	page	break	in	Google	Docs	that	you	just	inserted?	Here’s	how	to	see	page	breaks	in	Google	Docs:	Open	your	Google	document,	then	select	“View”	from	the	menu	bar.	Click	on	“Show	non-printing	characters”	from	the	options	available.	Alternatively,	you	can	use	the	keyboard	shortcut	“Ctrl”	+	“Shift”	+	“P”	(or	“Command”	+	“Shift”	+
“P”)	to	display	the	page	breaks.	How	To	Delete	Page	and	Section	Breaks	If	you	no	longer	need	page	and	section	breaks	in	your	document,	you	can	easily	remove	them	by	following	these	steps:	Open	your	Google	document	and	navigate	to	the	section	where	you	inserted	a	break.	Place	your	cursor	immediately	after	the	page	or	section	break.	Press	the
“Backspace”	key	on	your	keyboard	(or	“Fn”	+	“Delete”	for	Mac)	until	the	page	break	or	section	break	is	deleted.	You	can	treat	your	section	and	page	breaks	like	any	other	character	you	see	in	your	document.	Therefore,	you	can	delete	them	in	the	same	way	you	would	remove	words	from	your	work.	Frequently	Asked	Questions	What	Is	the	Shortcut
for	Page	Break	in	Google	Docs?	For	Windows	users,	press	the	keys	“Ctrl”	and	“Enter”	on	your	keyboard	to	insert	a	page	break	in	Google	Docs.	For	Mac	users,	press	“Command”	and	“Enter/Return”	simultaneously	instead.	What	Is	the	Difference	Between	a	Page	Break	and	a	Section	Break	in	Google	Docs?	If	you	insert	a	page	break,	you	can	only
continue	typing	and	adding	content	on	the	next	immediate	page	of	your	document.	However,	adding	a	section	break	divides	your	content	on	the	same	page.	Final	Thoughts	If	you	need	to	lay	out	your	document	properly,	page	breaks	in	Google	Docs	are	always	helpful.	Just	follow	our	guide	above,	and	you	should	be	able	to	insert	them	without	problems.
Want	a	quicker	way	to	make	progress	with	your	work?	Get	a	headstart	by	checking	out	our	premium	templates	today!	Use	the	code	“SSP”	to	purchase	them	at	50%	off.	Related:	Page	breaks	and	section	breaks	in	Google	Docs	allow	for	greater	control	over	the	layout	and	structure	of	your	content,	but	they	can	also	cause	issues.	If	you’ve	ever	found
yourself	struggling	with	awkward	page	breaks	that	disrupt	the	flow	of	a	document	or	with	section	breaks	that	create	unwanted	whitespace	or	page	numbering	issues,	you	probably	know	how	frustrating	they	can	be.	In	this	tutorial,	we’ll	show	you	how	to	remove	page	breaks	and	section	breaks	in	Google	Docs	so	that	you	can	regain	control	over	your
document’s	formatting.	Google	Docs	makes	it	easy	to	add	manual	page	breaks	to	your	documents	and	push	content	to	the	next	page	without	repeatedly	pressing	the	Enter/Return	key.	There	are	several	ways	to	do	that:	Use	the	Ctrl	+	Enter	(Windows	and	Chromebook)	or	Command	+	Enter	(Mac)	keyboard	shortcut.	Select	Insert	>	Break	>	Page	Break
on	the	Google	Docs	menu	bar.	Tap	the	Add	icon	and	select	Page	break	on	mobile	app	(iPhone,	iPad,	and	Android).	However,	if	you	insert	a	page	break	that	you	no	longer	need	or	add	one	accidentally,	it’s	important	to	know	how	to	remove	it.	To	delete	a	page	break	in	Google	Docs:	Position	the	cursor	on	the	start	of	the	section	after	a	page	break.	Press
the	Backspace	key	(Windows	and	Chromebook)	or	the	Delete	key	(Mac,	iOS,	and	Android).	Press	Backspace/Delete	repeatedly	if	there’s	vacant	space	between	the	cursor	and	the	page	break.	On	desktop	devices,	you	can	also:	Position	the	cursor	at	the	end	of	the	final	paragraph	before	the	page	break.	Press	Delete	(Windows),	Fn+Delete	(Mac),	or
Alt+Backspace	(Chromebook).	Press	the	key	or	keys	repeatedly	if	there’s	vacant	space	between	the	cursor	and	the	page	break.	If	you	want	to	read	through	the	contents	of	a	Google	Docs	document	without	manual	or	automatic	page	breaks	interrupting	the	flow,	try	switching	the	page	setup	to	the	Pageless	format.	To	do	that:	Open	the	File	menu	and
select	Page	setup.	The	Pageless	format	also	hides	elements	like	headers,	page	numbers,	and	watermarks.	To	switch	back	to	the	default	Pages	format,	open	the	File	menu,	select	Page	setup,	and	choose	the	Pages	tab.	To	enable	and	disable	Pageless	format	on	the	mobile	version	of	Google	Docs,	you	must:	Tap	the	More	icon	(three	dots)	on	the	top	right
of	the	screen.	Tap	Page	setup.	Enable	the	switch	next	to	Pageless.	Like	Microsoft	Word,	Google	Docs	on	desktop	devices	allow	you	to	add	section	breaks	to	documents.	There	are	two	types	of	section	breaks:	Section	break	(next	page):	Starts	a	section	break	on	a	new	page.	Section	break	(continuous):	Starts	a	new	section	within	the	same	Google	Docs
page.	To	add	a	section	break,	open	the	Insert	menu	and	select	Break	>	Section	break	(next	page)	or	Section	break	(continuous).	Section	breaks	help	separate	different	sections	of	your	document	in	Google	Docs.	However,	unlike	regular	page	breaks,	it	can	be	frustrating	to	remove	section	breaks	unless	you	know	how.	To	remove	a	section	break	in
Google	Docs:	Position	the	cursor	at	the	end	of	the	paragraph	before	the	section	break.	Press	Delete	(Windows),	Fn+Delete	(Mac),	or	Alt+Backspace	(Chromebook).	If	you	have	trouble	locating	section	breaks	in	a	document:	Open	the	View	menu	and	select	Show	section	breaks/Show	non-printing	characters.	You	should	then	see	section	breaks
throughout	the	document	as	dotted	lines.	Position	the	cursor	above	the	section	break’s	horizontal	line	and	press	Delete	(Windows),	Fn+Delete	(Mac),	or	Alt+Backspace	(Chromebook)	to	remove	it.	To	hide	section	breaks	again,	open	the	Insert	menu	and	remove	the	checkmark	next	to	the	Show	section	breaks/Show	non-printing	characters	option.
Removing	unwanted	page	breaks	and	section	breaks	in	Google	Docs	is	crucial	for	creating	a	polished	and	well-organized	document.	Although	it	may	take	a	few	attempts	to	get	the	hang	of	the	methods	above,	you’ll	soon	be	able	to	do	it	with	ease.	How	to	Get	Rid	of	Page	Breaks	in	Google	Docs?	Are	you	tired	of	unwanted	page	breaks	in	your	Google
Docs	documents?	It’s	frustrating,	isn’t	it?	You’re	not	alone.	Many	users	have	struggled	with	this	issue,	and	it’s	high	time	we	address	it.	In	this	article,	we’ll	tackle	this	common	problem	and	provide	solutions	on	how	to	get	rid	of	page	breaks	in	Google	Docs.	Why	Do	Page	Breaks	Happen	in	Google	Docs?	Before	we	dive	into	the	solutions,	it’s	essential	to
understand	why	page	breaks	occur	in	the	first	place.	Here	are	a	few	common	reasons:	•	Incorrect	spacing	and	formatting:	When	you	use	excessive	spacing,	irregular	spacing,	or	incorrect	formatting,	page	breaks	may	appear.	•	Too	many	carriage	returns:	Typing	multiple	carriage	returns	in	a	row	can	create	an	unnecessary	page	break.	•	Using	the
"Insert	page	break"	feature:	This	might	seem	obvious,	but	deleting	the	page	break	might	not	always	remove	it	completely.	•	Corrupt	file	or	formatting	issues:	Sometimes,	page	breaks	can	be	a	result	of	file	corruption,	edits,	and	formatting	errors.	How	to	Get	Rid	of	Page	Breaks	in	Google	Docs?	Now	that	we’ve	identified	the	common	reasons	for	page
breaks,	it’s	time	to	learn	how	to	eliminate	them.	Here	are	some	effective	solutions:	Solution	1:	Remove	Page	Break	using	the	"Hyphen"	Method	Place	your	cursor	at	the	beginning	of	the	page	break.	Press	the	–	(hyphen)	key.	This	will	create	a	non-breaking	hyphen.	Select	the	hyphen	and	use	Ctrl	+	Shift	+	Delete	(Windows)	or	Cmd	+	Shift	+	Delete
(Mac)	to	delete	it.	The	page	break	should	now	disappear.	Tip:	This	method	works	only	if	you	don’t	have	any	text	preceding	the	page	break.	If	you	do,	use	the	next	solution.	Solution	2:	Delete	Page	Break	using	the	"Selection"	Method	Select	the	entire	document	by	pressing	Ctrl	+	A	(Windows)	or	Cmd	+	A	(Mac).	Go	to	the	Edit	menu	and	select	Undo	(or
press	Ctrl	+	Z	or	Cmd	+	Z).	This	will	undo	any	recent	changes,	including	the	addition	of	the	page	break.	Alternatively,	you	can	also	use	the	keyboard	shortcut	Ctrl	+	Shift	+	>	(Windows)	or	Cmd	+	Shift	+	>	(Mac)	to	move	the	selected	text	to	the	next	page.	Solution	3:	Use	the	"Find	and	Replace"	Method	Go	to	the	Edit	menu	and	select	Find	and	replace
(or	press	Ctrl	+	H	or	Cmd	+	H).	In	the	"Find	what"	field,	type	^13,	which	represents	a	line	break.	Leave	the	"Replace	with"	field	blank.	Click	Replace	All	to	remove	the	page	break.	Solution	4:	Convert	File	to	HTML	and	Back	Go	to	the	File	menu	and	select	Download	as	>	HTML.	Open	the	downloaded	HTML	file	using	a	text	editor	or	an	HTML	editor
like	Notepad++.	Remove	the	unwanted	page	break	by	deleting	the	corresponding	HTML	code	(usually	).	Save	the	HTML	file	and	re-upload	it	to	Google	Drive.	Open	the	file	in	Google	Docs	to	verify	that	the	page	break	is	gone.	Additional	Tips	and	Tricks	•	Use	Google	Docs’	built-in	formatting	features:	Rethink	your	formatting	approach	and	use	Google
Docs’	built-in	formatting	tools,	such	as	headings,	lists,	and	multiple	columns,	to	reduce	the	need	for	manual	spacing	and	formatting.	•	Check	your	document’s	settings:	Ensure	your	document	is	set	to	Separate	pages	instead	of	Single	page,	which	can	sometimes	cause	issues.	•	Use	a	reliable	text	editor:	If	you’re	experiencing	frequent	page	breaks,
consider	using	a	reliable	text	editor	for	editing,	like	Sublime	Text	or	Atom,	before	importing	the	file	into	Google	Docs.	Conclusion	Removing	page	breaks	in	Google	Docs	is	achievable	with	the	right	techniques	and	a	little	patience.	By	understanding	the	common	causes	of	page	breaks,	using	the	provided	solutions,	and	following	the	additional	tips	and
tricks,	you’ll	be	well	on	your	way	to	a	page-break-free	Google	Docs	experience.	Remember,	it’s	always	a	good	idea	to	save	frequently	and	use	Google	Docs’	built-in	formatting	features	to	minimize	the	need	for	manual	intervention.	Jakarta-born,	Amsterdam-based	Markus	Klein,	a	freelance	writer,	and	editor,	originally	introduced	the	concept	of	"page
breaks"	in	his	2012	research	paper,	"The	Psychology	of	Page	Breaks	in	Digital	Document	Editors."	Your	friends	have	asked	us	these	questions	-	Check	out	the	answers!	Efficiently	dividing	content	across	different	pages	can	be	challenging,	but	Google	Docs'	page	break	feature	simplifies	the	task.	This	tool	splits	a	single	page	into	two	sub-pages,	helping
to	organize	and	structure	your	document.	Page	breaks	allow	you	to	end	a	page	without	adding	content,	creating	distinct	sections	within	your	document.	This	is	particularly	useful	for	academic	research	or	professional	content,	adding	both	organization	and	professionalism.	This	article	covers	the	step-by-step	process	of	adding	page	breaks	on	both
laptops	and	mobile	devices.	What	does	a	Page	Break	do	in	Google	Docs?A	page	break	is	a	formatting	tool	utilized	in	documents,	both	for	print	and	digital	use,	that	signals	the	conclusion	of	one	page	and	the	commencement	of	a	new	one.	Its	purpose	is	to	manage	how	content	is	displayed,	making	certain	parts	or	segments	start	on	fresh	pages	rather
than	continuing	on	the	same	page.	This	is	frequently	done	to	enhance	readability,	separate	chapters	or	sections,	and	enhance	the	overall	document	organization.	In	word	processing	software	like	Microsoft	Word	or	Google	Docs,	you	can	insert	a	page	break	to	ensure	content	begins	on	a	new	page.	This	element	is	meant	for	adjusting	layout	and	should
avoid	raising	suspicion	from	AI	or	plagiarism	detection	tools	due	to	its	common	and	functional	nature.	Benefits	of	Inserting	Page	Break	in	Google	DocsImproved	Document	Layout:	Page	breaks	in	Google	Docs	allow	you	to	logically	divide	content	into	distinct	sections,	enhancing	the	layout	of	longer	documents.Improved	Readability:	Dividing	content
with	page	breaks	makes	it	easier	for	readers	to	follow,	preventing	them	from	being	overwhelmed	by	long	paragraphs	or	sections.Professional	Presentation:	Proper	page	breaks	give	documents	a	more	sophisticated	and	professional	appearance,	ideal	for	academic	and	corporate	work.Customized	Formatting:	Page	breaks	enable	flexible	formatting	of
individual	sections,	allowing	adjustments	to	font	size,	spacing,	and	margins	for	specific	parts	of	the	document.How	to	Insert	Page	Breaks	in	Google	DocsStep	1:	Launch	Google	DocsTo	begin	with	adding	page	breaks	in	Google	Documents,	Launch	Google	Docs	on	your	web	browser	or	simply	click	here	to	open	a	Google	Doc.	Launch	Google	DocsStep	2:
Open	the	DocumentAccess	the	document	where	the	inclusion	of	page	breaks	is	required.	Additionally,	there's	the	option	to	generate	a	new	document	or	alternatively,	open	an	already	existing	one.	Open	the	Document	or	Create	a	New	DocumentStep	3:	Choose	the	Region	for	Applying	Page	BreaksOnce	the	document	is	opened,	proceed	to	select	the
specific	location	within	the	document	where	the	Page	Break	needs	to	be	inserted.	In	the	screenshot	below,	the	designated	area	has	been	highlighted,	indicating	that	the	Page	Break	will	be	implemented	at	this	point.	Select	the	area	to	apply	a	page	breakStep	4:	Click	on	InsertTo	incorporate	page	breaks	within	the	content,	it's	necessary	to	either	click
on	or	access	the	"Insert"	tab	located	in	the	upper	toolbar	of	the	main	interface	or	on	the	Google	Docs	website.	Top	many	bar	>	Click	on	InsertStep	5:	Select	Break	and	Choose	Page	BreakNow	you	will	encounter	a	dropdown	menu	containing	a	range	of	different	options.	Scroll	through	the	options	and	locate	the	"Break"	option,	then	proceed	to	click	on
it.	Once	clicked,	a	subsequent	dropdown	menu	will	appear,	presenting	various	alternatives.	One	of	these	options	is	the	"Page	Break."	Make	your	selection	accordingly.	Shortcut	Key	for	inserting	Page	Break:	You	can	also	insert	a	page	break	by	pressing	"Ctrl	+	Enter"	Break	>	Select	Page	BreakStep	6:	Preview	Page	BreakUpon	selecting	the	option,	the
Page	Break	will	be	seamlessly	incorporated.	Preview	the	designated	content	area,	which	will	now	appear	on	a	fresh	page,	resulting	in	an	alteration	to	the	overall	structure	and	layout.	Preview	Applied	Page	BreakWhat	is	Section	Break	in	Google	DocsA	section	break	in	Google	Docs	is	a	formatting	tool	used	to	divide	a	document	into	distinct	sections,
each	with	its	formatting,	layout,	or	properties.	It	enables	you	to	apply	different	formatting	styles,	headers,	footers,	page	numbering,	or	even	column	setups	to	different	parts	of	your	document.	Section	breaks	are	useful	when	you	want	to	create	sections	with	varying	styles	or	layouts	within	the	same	document.	Use	of	Section	Break	in	Google	DocsApply
different	headers	or	footers	to	various	parts	of	a	document.Change	page	numbering	styles	or	reset	page	numbers	within	different	sections.Adjust	margins,	columns,	or	orientation	for	specific	parts	of	the	document.Have	parts	of	the	document	with	unique	formatting,	such	as	landscape	orientation	for	an	image	or	table.How	to	Insert	a	Section	Break	in
Google	DocsSection	break	in	Google	Docs	is	one	of	the	features	that	provides	the	functionality,	which	is	quite	similar	to	a	page	break.	The	section	break,	helps	us	to	divide	a	particular	page	in	our	document	into	multiple	sections	or	subparts.	The	steps	for	inserting	a	section	break	in	Google	Docs	are	stated	below:	Step	1:	Open	the	Google
DocumentBegin	by	accessing	the	document	where	a	Section	Break	is	required.	You	also	have	the	option	to	either	create	a	new	document	or	open	an	existing	one.	Next,	identify	the	specific	region	from	which	you	intend	to	insert	the	Section	Break.	Open	Google	DocumentStep	2:	Click	on	InsertOnce	you've	opened	the	necessary	document,	proceed	to
select	the	"Insert"	Tab	located	in	the	upper	menu	of	the	Google	Docs	interface.	Top	Menu	Bar	>	Click	on	InsertStep	3:	Select	Break	and	Choose	Section	Break	Next	Page	or	ContinousUpon	clicking	the	"Insert"	tab,	a	variety	of	options	will	appear	in	the	drop-down	menu.	From	the	options,	choose	"Break."	Within	the	"Break"	option,	select	the	sub-
option	labeled	"Section	Break."	It's	important	to	note	that	there	are	two	distinct	types	of	section	breaks	available.	The	next	section	will	start	on	the	following	page	of	our	document.	What	is	Section	Break	ContinuousThe	section	break	will	be	inserted	within	the	same	working	page.	Insert	>	Break	>	Section	BreakStep	4:	Preview	Section	Break	is	added
successfullyNow,	take	a	moment	to	preview	and	confirm	that	the	aforementioned	steps	have	been	successfully	implemented	in	your	document.	Section	Break	Applied	SuccessfullyHow	to	Show	Page	Breaks	in	Google	DocsStep	1:	Click	on	the	View	TabTo	make	the	Page	Breaks	visible	in	our	Google	Docs.	Navigate	to	the	top	menu	bar	of	Google	Docs
and	click	on	"View".	Clicking	on	View	TabStep	2:	Select	Show	Non-Printing	CharactersAfter	selecting	the	"View"	tab	within	the	sub-options,	proceed	to	choose	and	enable	the	"Show	Nonprinting	Characters"	option.	Selecting	show	non-printing	characters	optionStep	3:	View	the	BreaksAfter	clicking	on	this	option,	we	can	easily	view	the	page	breaks,
which	are	added	to	our	document	in	Google	Docs.	Page	Breaks	are	ShownHow	to	Insert	Page	Breaks	in	Google	Docs	on	AndroidGoogle	Docs	is	compatible	with	mobile	devices	in	terms	of	portable	applications,	using	this	application	we	can	add	or	insert	page	breaks	in	our	content	as	per	our	requirements.	So	for	inserting	page	breaks,	we	need	to
perform	the	below-specified	steps:	Step	1:	Install	Google	DocsDownload	the	Google	Doc	Application	on	your	Mobile	device.	Installing	Google	DocsStep	2:	Open	the	Google	DocOnce	the	installation	of	the	application	is	finished,	the	next	steps	involve	either	creating	a	new	document	or	accessing	an	already	existing	one.	In	this	document.	Opening	the
DocumentStep	3:	Click	on	the	Edit	ButtonNow	click	on	the	Edit	button,	it	will	be	visible	on	the	bottom	right	corner	of	the	mobile	screen	in	blue	color.	Clicking	on	Edit	IconStep	4:	Choose	Page	Break	LocationNow,	it's	essential	to	select	the	specific	area	from	which	the	page	break	will	be	applied.	As	shown	in	the	screenshot	below,	you'll	notice	that
we've	clicked	on	the	text	"3.3.	Task	Identification"	to	indicate	where	the	page	break	is	to	be	implemented.	Selecting	the	AreaStep	5:	Click	on	(+)	Icon	and	Select	Page	BreakOnce	the	page	break	location	is	chosen,	the	next	step	involves	applying	the	page	break	itself.	Click	on	the	insert	(+)	icon,	and	from	the	dropdown	menu,	opt	for	the	"Page	break".
Clicking	on	the	insert	button	and	select	the	Page	break	optionStep	6:	Preview	Page	BreakUpon	selecting	the	"Page	Break"	option,	the	page	break	will	be	implemented	starting	from	the	chosen	area	or	text,	as	illustrated	in	the	screenshot	below.	Page	Break	AppliedInserting	Page	Break	in	Google	Docs	On	iPhoneNote:	The	process	of	inserting	a	Page
Break	in	your	Google	Docs	document	remains	consistent	for	both	iPhone	and	Android	devices.	Please	follow	the	above	steps	to	insert	page	break	in	your	iOS	device.	How	to	Remove	Page	Breaks	and	Section	Breaks	in	Google	DocsStep	1:	Open	the	DocumentWe	need	to	open	the	document	in	which	we	need	we	need	to	delete	the	page	and	section
break.	We	can	open	the	existing	document	present	on	our	Google	Account,	or	we	can	also	upload	it	from	our	local	device.	Opening	the	DocumentStep	2:	Navigate	to	the	Break	Section	and	Place	the	Cursor	Once	you've	opened	the	document,	navigate	to	the	section	where	you've	added	a	break.	Then,	position	your	cursor	immediately	after	the	page	or
section	break.	Placing	the	CursorStep	3:	Use	the	Backspace	Key	on	WindowsAfter	repositioning	the	cursor	correctly,	proceed	to	press	the	backspace	key	located	on	your	keyboard.	Keep	pressing	this	key	until	the	page	break	or	section	break	is	entirely	removed	from	your	document.	Shortcut	key	for	Mac:	Use	"Fn+	Delete”	to	Delete	Page	and	Section
Breaks	Using	Backspace	Key	to	remove	breakSHoConclusionInserting	page	breaks	in	a	Google	document	can	significantly	improve	the	readability	and	presentation	of	your	main	content.	Utilizing	this	feature	allows	you	to	structure	your	document	professionally,	making	it	easier	for	readers	to	navigate	and	visualize	the	content.	Page	breaks	can	be
added	using	both	mobile	devices	and	desktops.	The	steps	outlined	in	this	article	will	guide	you	through	the	process	of	inserting	page	breaks	seamlessly,	ensuring	you	encounter	no	difficulties	or	issues.	Page	breaks	and	section	breaks	are	useful	tools	in	Google	Docs	to	control	the	layout	and	formatting	of	your	document.	Here	is	a	comprehensive	guide
on	how	to	add,	view,	and	remove	these	breaks.To	add	a	page	break	in	Google	Docs:Place	your	cursor	where	you	want	the	page	breakClick	Insert	>	Break	from	the	menuSelect	Page	breakA	page	break	will	move	all	text	after	the	cursor	to	the	next	page.You	can	also	add	a	page	break	before	a	specific	paragraph:Select	the	entire	paragraph	or	place	your
cursor	anywhere	in	the	paragraphClick	Format	>	Line	&	Paragraph	Spacing	>	Add	Page	Break	BeforeThis	will	move	the	selected	paragraph	to	the	top	of	the	next	page.There	are	two	types	of	section	breaks	in	Google	Docs:Section	break	(continuous)	–	Starts	a	new	section	on	the	same	pageSection	break	(next	page)	–	Starts	a	new	section	on	the	next
pageTo	add	a	section	break:Place	your	cursor	where	you	want	the	section	breakClick	Insert	>	Break	from	the	menuSelect	the	type	of	section	break	you	wantSection	breaks	allow	you	to	have	different	headers,	footers,	margins	and	other	formatting	within	the	same	document.Page	breaks	in	Google	Docs	do	not	display	any	visible	indicator.	However,
section	breaks	have	a	blue	dotted	line	showing	where	the	section	begins.To	show	section	breaks:Click	View	>	Show	Section	BreaksTo	hide	section	breaks:Click	View	>	Show	Section	Breaks	to	uncheck	itShowing	section	breaks	helps	you	visually	see	where	your	sections	divide,	but	you	can	hide	them	if	you	find	them	distracting.To	remove	a	page
break:Click	under	the	page	breakPress	Backspace	or	Delete	key	until	the	page	break	is	removedYou	may	need	to	press	Backspace	or	Delete	multiple	times	to	completely	eliminate	the	break.To	remove	a	section	break:Make	section	breaks	visible	by	clicking	View	>	Show	Section	BreaksClick	above	the	section	breakPress	Backspace	or	Delete	key	to
remove	the	dotted	lineOnce	the	section	break	line	disappears,	the	section	break	will	be	eliminated.Here	is	a	comparison	of	page	breaks	and	section	breaks:|	Feature	|	Page	Break	|	Section	Break	||-|-|-||	Location	|	Moves	all	below	text	to	next	page	|	Starts	new	section	on	same	or	next	page	||	Visibility	|	Not	visible	|	Dotted	line	visible	||	Usage	|	Separate
topics	or	sections	|	Customize	formatting	within	document	||	Remove	|	Delete	under	break	|	Delete	above	section	break	line	|


